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 Menu Designer Overview

Menu Designer is a component of StepUp’96 which you can use to modify StepUp Menu and manage 
menu files.

The organization of StepUp Menu and properties of its items are stored on your disk in a menu file 
(extension .mnu). There may be several menu files on your disk, containing different menus, but only one
such a file can be active at a time.

When you choose the Customize command from StepUp Menu (or run Menu Designer without command
line parameters), the currently active menu file is opened, allowing you to modify its contents and 
therefore to modify StepUp Menu. After you have saved changes to the menu file, the updated menu is 
immediately available for use. With Menu Designer you can also open and modify other menu files, not 
just the active one.

With Menu Designer you can add new commands to StepUp Menu, delete existing ones, change 
positions of the menu items, modify their properties. Menu Designer also supports drag-and-drop 
operations for menu items, as well as transferring data through the clipboard.

With Menu Designer you can create several menu files with different sets of commands and activate them
as needed. Menu Designer allows you to move menu items between menu files, store separate items or 
whole submenus in different files, combine several menu files into a single menu file.

StepUp’96 comes with a ready to use menu file StepUp.mnu. It contains a number of useful commands, 
which you can use as starting points for constructing your own commands. 

For further information please refer to the descriptions of the commands and dialog boxes of Menu 
Designer in this Help.



 Terminology used in this Help

StepUp Menu
a set of commands provided by StepUp’96. Can be accessed in two different ways: 

· as a part of the Context Menu, after you have selected one or more file objects which can be 
processed by the commands of StepUp Menu, 

· as the Taskbar Menu, without any file objects selected. 

Menu file
a file (extension .mnu) containing information about organization and properties of the StepUp menu. 

Active menu file
the menu file which is used by StepUp’96 to display StepUp Menu. Only one menu file can be active 
at a time. If none menu file is set active, no StepUp Menu is available for use.

Menu Designer
an application used to modify menu files, including the active menu file, and thus to customize 
StepUp Menu. 

Menu command
a menu item which executes a command when you select it in StepUp Menu.

Menu node
a menu item which opens a submenu when you select it in StepUp Menu.

Root menu node
the menu node at the top of the menu hierarchy. Its name is shown in the windows context menu and 
as the tooltip of the Taskbar Menu.

Submenu
a set of menu items grouped together. A submenu may contain menu commands, menu nodes and 
separators.

File object
A file or a file system folder (not a virtual folder).

Selected file object
A file object which is selected in an Explorer window. Selected objects are highlighted in the list of the 
files. There may be several file objects selected simultaneously.

Focused file object
A file object which is indicated by a rectangle around its name in an Explorer window. No more than 
one object can have a focus at a time. 

Primary selected file object
The focused file object if it is selected. If the focused file object is not selected, the first of the selected
file objects.

Verb
A command defined for a particular file type. To view the list of verbs defined for a particular file type, 
open an Explorer window, choose    View Options from its menu, switch to the File Types page, 



select the file type in question, and click on the Edit button. The verbs will appear in the Actions list. 



How to run Menu Designer

There are several ways:

· Choose Customize from StepUp Menu. This opens the currently active menu file and runs Menu 
Designer to modify it. If you don’t have this item in the StepUp menu, or cannot access it for some 
reason, use one of the other methods.

· Choose Menu Designer from either Start Menu or StepUp folder on your Desktop. These items may 
not be available if you have declined their creation while installing StepUp’96.

· Using Explorer, open folder in which you have installed StepUp’96, and double-click file 
Designer.exe. This will automatically open the active menu file for editing, if any.

· To modify an arbitrary menu file, double-click its name in the Explorer window.



How to determine the active menu file

Run Menu Designer and choose File | Activate from its menu. When the dialog box opens, it shows the 
active menu file at the bottom.



How to activate a different menu file

Run Menu Designer and choose File | Activate from its menu. When the dialog box opens, select the 
menu file to activate and press OK. 

Note StepUp’96 maintains the information about the active menu file on the per-user basis. That is, if 
your computer is used by more than one user, every user may activate and use his or her private menu 
file. The changes to the private menu file will not affect menu files used by other users, unless two or 
more users activate the same menu file as StepUp Menu.    



How to store a part of menu in a separate file

While editing a menu file, select the menu item you wish to store (which can be a command or a node) 
and choose the File    Export command from the menu bar. Menu Designer displays the Export dialog 
box, similar to the Save As dialog box, so you can name the menu file in which to store the selected item.
If you are exporting a menu node, all its child items are exported as well. You can insert the saved part of 
the menu into the same or some other menu file later on by using the File    Import command of Menu 
Designer.



How to move a part of menu between menu files

While Menu Designer can only work with one menu file at a time, you can run several instances of Menu 
Designer and work with different menu files simultaneously. To move or copy a part of a menu file into 
another menu file, first open both of the menu files (by double-clicking their names in an Explorer window,
for example). Select the menu item you wish to move or copy (which can be a command or a node) and 
choose either the Edit Cut (to move) or Edit Copy (to copy) command from the menu bar, to place the 
selected item on the clipboard. Now switch to another instance of Menu Designer (using the Taskbar, for 
instance) and select the menu item above which you wish the transferred part of the menu file to appear. 
Finally choose Edit Paste
to insert the menu item being transferred at the marked position. 



How to add a command to StepUp Menu

Run Menu Designer and select an item above which you want to insert the new command. Then choose 
the Insert Command from the menu bar or from the Shortcut Menu. Menu Designer will create a new 
command item named New Command. 

Change the name of the new item to reflect the purpose of the command you are creating. This name will 
appear in the StepUp menu. To make one of the characters of the name underlined in the StepUp Menu, 
put an ampersand (&) in front of it.

Now you have created a new command. Menu Designer initially assigns no properties to it, so if you were
choosing such a command from the StepUp Menu, it would do nothing. To make the command to do 
some useful work, you need to specify its properties. To do this, make sure the menu item in question is 
still selected and choose Edit Properties in the menu bar (or just double-click the menu item). Menu 
Designer will show the Menu Item Properties dialog box, which you can use to specify the file to be run 
when you choose the command from the StepUp Menu, its parameters (if needed), the folder in which its 
execution begins, etc. 

After you have set the desired properties of the command, choose the Save command to save the 
changes to the menu file. From this time on the newly created command appears among other items of 
the StepUp menu and you can use it to do the work for you. 

Tip Instead of creating a fresh new command, you can also create a copy of an existing command and 
then modify its properties. Use the Edit Copy and Edit Paste commands for this purpose.



How to make a command to run an application

First run Menu Designer and create a new command which you will later choose from StepUp Menu to 
run the application. In the File field of the Menu Item Properties dialog box specify the full path to the 
executable file of the application. You can also specify other properties of the command, if needed. For 
example, to make the application start with its main window maximized, choose such an option in the 
Window list.  

After you have set the desired properties of the command, choose the Save command to save the 
changes to the menu file. From this time on the newly created command appears among other items of 
the StepUp menu and you can use it to launch the application. 

Example:
see command New text file, included in the original StepUp Menu.



How to make a command to process an associated file

First run Menu Designer and create a new command which you will later choose from StepUp Menu to 
process a file. In the File field of the Menu Item Properties dialog box specify one of the file macros 
corresponding to the full path of the focused file, for example, %1. The focused file object is indicated by a
rectangle around its name in an Explorer window. 

After you have set the desired properties of the command, choose the Save command to save the 
changes to the menu file. From this time on the newly created command appears among other items of 
the StepUp menu. To use this command, select the file you wish to process in an Explorer window and 
choose the command from the StepUp part of its context menu. StepUp Menu Handler will substitute the 
file macro %1 with the actual path of the selected file object and launch its associated application to 
process the file.

Note Since such a command makes sense only if a file is selected, you may wish to turn on the Disable 
menu item if selected: Folder option on the Advanced page of the Menu Item Properties Dialog 
Box . Also, to prevent this command from being chosen if no files selected (as is in case of using the 
StepUp menu as the Taskbar Menu), you may wish to turn on the Disable menu item if selected: 
Nothing option as well.

Note Keep in mind that a number of different associations may exist for a particular file type. Such 
associations are called verbs. You can specify the verb to be executed when you choose the 
command in the StepUp Menu by entering its name in the Verb area of the Menu Item Properties 
Dialog Box for the menu item. If you leave the Verb area empty, Windows will attempt to execute the 
default verb defined for the file type. 

Example:
see command Open Maximized, included in the original StepUp Menu.



How to make a command to process an arbitrary file

First run Menu Designer and create a new command which you will later choose from StepUp Menu to 
process a file. In the File field of the Menu Item Properties dialog box specify the full path to the 
application executable which you wish to be used in processing a file. In the Parameters area specify one
of the file macros corresponding to the full path of the focused file, for example, %1. The focused file 
object is indicated by a rectangle around its name in an Explorer window. 

After you have set the desired properties of the command, choose the Save command to save the 
changes to the menu file. From this time on the newly created command appears among other items of 
the StepUp menu. To use this command, select the file you wish to process in an Explorer window and 
choose the command from the StepUp part of its context menu. StepUp Menu Handler will substitute the 
file macro %1 with the actual path of the selected file object and supply it as the parameter to the 
application you have specified in the File area. The application will open the selected file for processing, 
even if it is not associated with the type of the file. 

Note Since such a command makes sense only if a file is selected, you may wish to turn on the Disable 
menu item if selected: Folder option on the Advanced page of the Menu Item Properties Dialog 
Box . Also, to prevent this command from being chosen if no files selected (as is in case of using the 
StepUp menu as the Taskbar Menu), you may wish to turn on the Disable menu item if selected: 
Nothing option as well.

Examples:
see commands Open with Notepad and Open with Wordpad, included in the original StepUp Menu.



How to make a command to open a specific folder

First run Menu Designer and create a new command which you will later choose from StepUp Menu to 
open the folder. In the File field of the Menu Item Properties dialog box specify the full path to the folder 
which you wish to be opened when you choose this command from the StepUp Menu. If you want the 
folder to be opened in a single-pane window (a window without the folder tree), specify open in the Verb 
field or leave this field empty. If you wish the folder to be opened in a double-pane window (a window 
showing both the folder tree and the contents of the folder), specify explore in the Verb field of the dialog 
box.

After you have set the desired properties of the command, choose the Save command to save the 
changes to the menu file. From this time on the newly created command appears among other items of 
the StepUp menu. You can use this command from both the context menu and the Taskbar Menu.

Note You can use file macros to specify locations of the special folders.

Examples:
see groups of commands Go to Folder and Go to Drive, included in the original StepUp Menu.



File menu commands

The File menu offers the following commands:

New
Creates a new menu file.

Open
Opens an existing menu file.

Save
Saves an opened menu file using the same file name.

Save As
Saves an opened menu file to a specified file name.

Activate
Activates a menu file as the StepUp Menu.

Import
Imports an existing menu file into the menu file being edited.

Export
Exports the selected menu item or node to a specified file name.

Exit
Exits Menu Designer.



Edit menu commands

The Edit menu offers the following commands:

Undo
Reverse previous editing operation, if possible.

Cut
Deletes data from the menu file and moves it to the clipboard.

Copy
Copies data from the menu file to the clipboard.

Paste
Pastes data from the clipboard into the menu file.

Move Up
Move Down

Change the order of items within the same submenu.
Move Level Up
Move Level Down

Move the selected item between submenus of different levels in the menu hierarchy.
Delete

Deletes the selected menu item.
Rename

Rename the selected menu item or node.
Test

Runs the selected menu command.
Properties

Displays properties for the selected menu item.



View menu commands

The View menu offers the following commands:

Toolbar
Shows or hides the toolbar.

Status Bar
Shows or hides the status bar.

Expand All
Expands all menu nodes.

Options
Shows options for Menu Designer.



 Insert menu commands

The Insert menu offers the following commands:

Command
Inserts a new menu command above the currently selected menu item.

Node
Inserts a new menu node above the currently selected menu item.

Separator
Inserts a new menu separator above the currently selected menu item.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help Topics
Offers you an index to topics on which you can get help.

About Menu Designer
Displays the version number of this application and the registration information.



 Shortcut menus

Menu Designer provides a number of shortcut menus for various components of its user interface. The 
shortcut menus provide quick access to many tools used in Menu Designer:

Shortcut menu for menu items
Shortcut menu for edit boxes



 Shortcut menu for menu items

The Shortcut menu for menu items is displayed after you click with the alternative mouse button within the
client area of the Menu Designer window. The Shortcut menu provides quick mouse access to many tools
used in Menu Designer. It offers the following commands:

Insert
Command
Node
Separator

Duplicate commands of the Insert menu

Cut
Copy
Paste
Delete
Rename
Test
Properties

Duplicate commands of the Edit menu



 Shortcut menu for edit boxes

The shortcut menu for an edit box is displayed after you click with the alternative mouse button within the 
edit box area. It can also be summoned by pressing Shift+F10 or clicking on a small square at the right-
bottom corner of the edit box. The shortcut menu offers one or more of the following commands:

Edit
Generic editing commands to be performed on the contents of the edit box.

Choices
the list of pre-set lines which, when chosen, replace the current text of the edit box. You can manipulate 
the contents of this list by choosing Properties from the shortcut menu for the edit box. 

Add to Choices
adds the current text of the edit box to the Choices submenu

Recent
the history list of the lines used in the edit box. When you close the dialog box by pressing OK, the 
contents of the edit box is added to the top of this list. You can manipulate the contents of this list by 
choosing Properties from the shortcut menu for the edit box. 

Browse for File
opens a dialog box which allows you to choose a file, which full path is to be inserted in the edit box. 

Browse for Folder
opens a dialog box which allows you to choose a folder, which full path is to be inserted in the edit box. 

Properties
opens the Properties for the Edit Box dialog box. 



 Shortcut menu for the list of ...

The shortcut menu for a list box is displayed after you click with the alternative mouse button within the 
list box area. It can also be summoned by pressing Shift+F10 or clicking on a small square at the right-
bottom corner of the list box. The shortcut menu offers one or more of the following commands:

Insert New
allows you to insert a line in an empty list box

Insert Before
Insert After

allow you to insert a new line in a list box before or after the currently selected line

Modify
allows you to modify the currently selected line in the list box

Remove
deletes the currently selected line in the list box

Remove All
empties the list box

Move Up
Move Down

move the currently selected line in the list box up or down

Properties
opens the Properties for the list of ... dialog box. 



 ‘Properties for Edit Box’ Dialog Box

Use this dialog box to change properties of an edit box of Menu Designer. It contains one or more of the 
following pages:

Choices
list of items which appear in the Choices submenu of the edit box shortcut menu. 

Recent
list of items which appear in the Recent submenu of the edit box shortcut menu. 



 ‘Properties for the list of ...’ Dialog Box

Use this dialog box to change properties of the corresponding list of items (Recent or Choices) associated
with an edit box. It contains the following areas:

Max. number of lines
the maximum number of lines the associated list of items may contain. If Auto arrange lines option is 
checked for the Choices list, then when you add a line to the list by using the command Add to 
Choices from the shortcut menu for the edit box, and the list already contains the Max. number of 
lines, the last line of the list is automatically deleted and the new line is added to the top of the list.

Auto arrange lines
when checked causes the corresponding list of items to be automatically rearranged when you choose 
an item of that list from the shortcut menu for the edit box: the item you have chosen is moved to the 
top of the list. This option is always enabled for the Recent lists. 

Confirm Remove
when checked, causes Menu Designer to prompt you to confirm the removing of a line from the list. 

Confirm Remove All
when checked, causes Menu Designer to prompt you to confirm the removing of all lines from the list. 



New command (File menu)

Use this command to create a new menu file in Menu Designer.

You can open an existing menu file with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing menu file in a window.

You can create new menu files with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



Save command (File menu)

Use this command to save the menu file being edited to its current name and directory.    When you save 
a menu file for the first time, Menu Designer displays the Save As dialog box so you can name your 
menu file.    If you want to change the name and directory of an existing menu file before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the menu file being edited.    Menu Designer displays the Save As 
dialog box so you can name your menu file.    

To save a menu file with its existing name and directory, use the Save command.



Activate command (File menu)

Use this command to activate a menu file as StepUp Menu.    Menu Designer displays the Activate Menu
File dialog box so you can specify which menu file to activate.    



Import command (File menu)

Use this command to import a menu file into the menu file being edited. When you choose this command,
Menu Designer displays the Import dialog box so can select the menu file to import. The menu file being 
imported is inserted before the currently selected menu item or node in the window. If the root menu node
is selected, the Open command is performed instead. 



Export command (File menu)

Use this command to export the currently selected menu item or node to a separate menu file. When you 
choose this command, Menu Designer displays the Export dialog box so can name the menu file. If you 
are exporting a menu node, all its child items are exported as well. If the root menu node is selected, the 
Export command saves a copy of the whole menu file being edited under a different name.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four menu files you 
closed.    Choose the number that corresponds with the menu file you want to open.



Exit command (File menu)

Use this command to end your Menu Designer session.    You can also use the Close command on the 
application Control menu.    Menu Designer prompts you to save menu files with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data (a menu   command   or a menu node) from the 
menu file and put it on the clipboard.    This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data (a menu command or a menu node) onto the clipboard.    This 
command is unavailable if there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Move Up command (Edit menu)

Use this command to move the selected menu item or node above the previous one within the same 
submenu.    This command is unavailable if the selected item is the first one in the submenu.

You can also drag and drop the item to the desired position.

Shortcuts
Keys: CTRL+UP



Move Down command (Edit menu)

Use this command to move the selected menu item or node after the next one within the same submenu.  
This command is unavailable if the selected item is the last one in the submenu.

You can also drag and drop the item to the desired position.

Shortcuts
Keys: CTRL+DOWN



Move Level Up command (Edit menu)

Use this command to move the selected menu item or node to the parent submenu, if any. This command
is unavailable if the selected item is in the submenu of the highest level.

You can also drag and drop the item to the desired position.

Shortcuts
Keys: CTRL+LEFT



Move Level Down command (Edit menu)

Use this command to move the selected menu item to a node following the selected item. This command 
is unavailable if the item following the selected item is not a node.

You can also drag and drop the item to the desired position.

Shortcuts
Keys: CTRL+RIGHT



 Delete command (Edit menu)

Use this command to delete the selected menu item.

Shortcuts
Keys: Del



 Rename command (Edit menu)

Use this command to rename the selected menu item.

You can also click on the selected item to rename it.



 Test command (Edit menu)

Use this command to run the selected menu command. 

Note This command executes the menu item as if it were chosen from Taskbar Menu, i.e. no selected file 
objects is supplied to it. To test the menu item in the Context Menu mode, save the menu file being 
edited, select a file object in an Explorer window and choose the menu item from the Context Menu.



 Properties command (Edit menu)

Use this command to view and/or modify properties of the selected menu command. When you choose 
this command, Menu Designer displays the Menu Item Properties dialog box.

You can also double click on the selected item to modify its properties.

Shortcuts
Keys: ALT+ENTER



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in Menu Designer, such as File Open.    A check mark appears next to the menu item when 
the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Menu Designer.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new menu file.

Open an existing menu file.    Menu Designer displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active menu file or template with its current name.    If you have not named the 
menu file, Menu Designer displays the Save As dialog box.

Remove selected data from the menu file and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the insertion point.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Menu Designer window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

If a menu command is currently selected, the left area of the status bar shows its description.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



 Expand All command (View menu)

Use this command to expand all nodes of the menu hierarchy. 



 Options command (View menu)

Use this command to view and/or modify options for Menu Designer. When you choose this command, 
Menu Designer displays the Options for Menu Designer dialog box.



 Command command (Insert menu)

Use this command to insert a new menu command above the currently selected menu item. 

Shortcuts
Keys: Ins



 Node command (Insert menu)

Use this command to insert a new menu node above the currently selected menu item. 



 Separator command (Insert menu)

Use this command to insert a new menu separator  above the currently selected menu item. 



Help Topics command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Menu Designer and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Menu Designer.



Context Help command 

Use the Context Help command to obtain help on some portion of Menu Designer.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then 
click somewhere in the Menu Designer window, such as another Toolbar button.    The Help topic will be 
shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and menu file.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Maximize button
Minimize button
Name of the application
Name of the menu file
Restore button



Scroll bars

Displayed at the right and bottom edges of the menu file window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the menu file.    You can use the mouse to scroll to other 
parts of the menu file.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Menu Designer window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



 Options for Menu Designer Dialog Box 

Use this dialog box to change options for Menu Designer. It contains the following areas:

Show menu items in bold
When checked, causes names of the menu commands and nodes in the menu hierarchy to be shown
in bold typeface. 

Show icons for menu items
When checked, causes small icons to be displayed next to the names of the menu items. 

Prompt to activate menu file on closing
When checked, causes Menu Designer, when you close it, to prompt you to activate the menu file 
being edited, if its name differs from the name of the current active menu file.

Activate previous instance, if found
When checked, causes Menu Designer, when you start it without command line arguments, to search
for another running instance of Menu Designer and switch to it, if found. This option is ignored if you 
start Menu Designer specifying the menu file to edit. In the latter case, a new instance of Menu 
Designer is always opened.



 Activate Menu File Dialog Box 

Use this dialog box to activate a menu file to be used as StepUp Menu. Only one such file can be set 
active at a time.



 Menu Item Properties Dialog Box

Use this dialog box to change properties of an item of the StepUp Menu. It contains the following pages:

General
Advanced



Menu Item Properties: General

Use this property page to change general properties of an item of the StepUp Menu. It contains the 
following areas:

Name
Name of the menu item as it should appear in the StepUp Menu. Put an ampersand (&) before the 
letter you want to be underlined in the menu name.

File
Primary file object to be executed when you select this menu item from the StepUp menu, usually a
complete path to the file object. You can use the environment variables and file macros in this area.
File object may be one of the following:

· Executable file (extensions EXE or COM). When you choose the menu item, StepUp runs this 
file, supplying the text specified in the Parameters area of the dialog box as the command line 
argument.

· Associated file (a file with extension for which a verb is defined). When you choose the menu 
item, StepUp performs the verb specified in the Action area of the dialog box.

· Folder. When you choose the menu item, StepUp opens the folder for browsing its contents.

Parameters
Text to be supplied as the command line argument when you select this menu item from the StepUp 
menu. You can use the environment variables and file macros in this area. If the File area specifies 
not an executable file, the contents of this area is ignored.

Start in
Folder which StepUp should make current before executing the menu item. You can use the 
environment variables and file macros in this area. 

Window
Specifies how you want the window to be displayed when you choose the menu item (normal, 
minimized, or maximized). 

Action
The verb to be applied to the file object specified in the File area when you choose the menu item. If 
no verb is specified, the default verb is assumed. For the list of defined verbs, open folder “My 
Computer”, choose “View - Options”    from menu, and go to the property page “File types”. 

Description
Text describing the menu item. If you access StepUp Menu through the contents menu for a file 
object(s) in a Browser or Explorer window, this text is displayed in the status bar of the window when 
you select the menu item. You can use the environment variables and file macros in this area. In 
addition, special character combinations are recognized by StepUp when displaying the description:

^f the original text specified in the File area, before substitutions for the environment variables 
and file macros are performed.

^F the resulting text specified in the File area, after substitutions for the environment variables 
and file macros are performed.

^p the original text specified in the Parameters area, before substitutions for the environment 
variables and file macros are performed.



^P the resulting text specified in the Parameters area, after substitutions for the environment 
variables and file macros are performed.

^s the original text specified in the Start in area, before substitutions for the environment 
variables and file macros are performed.

^S the resulting text specified in the Start in area, after substitutions for the environment 
variables and file macros are performed.

^a the text specified in the Action area.

See also:

Menu Item Properties Dialog Box
Menu Item Properties: Advanced



Menu Item Properties: Advanced

Use this property page to change advanced properties of an item of the StepUp Menu. It contains the 
following areas:

Before executing the command
Actions to perform after you choose the menu item but before the execution of the command begins. 
This group contains the following areas:

Prompt for confirmation
When checked, StepUp displays the confirmation dialog box before executing the command. The 
dialog box contains the resulting values of the fields File, Parameters, Start in, Window, and 
Verb, which you can modify before continuing the command.    

Copy selection to clipboard
When checked, StepUp copies the currently selected file objects, if any, to the clipboard, before 
executing the command. You can use this option, for example, to pass arguments to applications 
via the clipboard.

Note To use this option effectively, the application you are running must be appropriately 
designed. An example of such an application is File Handler, which accepts information from the 
clipboard if the source argument in its command line is specified by the symbol @. 

Disable menu item if selected:
Conditions under which the menu item should be disabled. This group contains the following areas:

Nothing
When checked, StepUp disables the menu item if no file objects had been selected before 
opening the StepUp menu. This condition is satisfied if StepUp Menu is opened as Taskbar Menu.
It is not satisfied if StepUp Menu is opened as the context menu (by a right-click on a file object), 
since in this case there always is at least one object selected. 

Multiple objects
When checked, StepUp disables the menu item if more than one file objects had been selected 
before opening the StepUp menu. This condition is never satisfied if StepUp Menu is opened as 
Taskbar Menu. 

Folder
When checked, StepUp disables the menu item if a folder had been selected before opening the 
StepUp menu. This condition is never satisfied if StepUp Menu is opened as Taskbar Menu. If 
more than one file object is selected, only the the primary one is examined to satisfy this 
condition.

File
When checked, StepUp disables the menu item if a file had been selected before opening the 
StepUp menu. This condition is never satisfied if StepUp Menu is opened as Taskbar Menu. If 
more than one file object is selected, only the primary one is examined to satisfy this condition.

Confirm if more objects selected than:
When checked, StepUp asks you to confirm the execution of the command if the number of the 
selected file objects exceeds the specified number. Possible values are between 1 and 255.    

See also:



Menu Item Properties Dialog Box
Menu Item Properties: General



 Environment variables

Environment variables control the behavior of some batch files and programs and control the way MS-
DOS appears and works. The SET command is often used in the AUTOEXEC.BAT or CONFIG.SYS files 
to set environment variables. Examples of the environment variables are COMSPEC, specifying the DOS 
path to the MS-DOS command interpreter, and    WINDIR, specifying the folder in which Windows has 
been installed. For more information on environment variables please refer to documentation on MS-
DOS.

You can use environment variables in the fields File, Parameters, and Start In of the Menu Item 
Properties Dialog Box. References to environment-variable strings have the form: %variable%. For each
such reference, the %variable% portion is replaced with the current value of that environment variable. 

The replacement rules are the same as those used by the command interpreter. Case is ignored when 
looking up the environment-variable name. If the name is not found, the %variable% portion is left 
undisturbed. If both environment variables and file macros are used in the same line, the values of the 
environment variables are substituted first. 

For example, if you specify the field Start In of a menu command as “%windir%” (without quotes), the 
execution of the command will begin in the folder in which Windows is installed (usually C:\Windows).



 File macros

File macros are special character combinations which can be specified in the fields File, Parameters, and
Start In of the Menu Item Properties Dialog Box. StepUp Menu Handler substitutes the file macros 
based on the context in which the StepUp Menu is invoked before executing its menu commands. 

File macros can be divided in several groups on the basis of their priority. The following file macros have 
the highest priority, i.e. StepUp Menu Handler attempts to recognize and process them first of all:

%(StepUp)
Substituted with the path to the folder in which StepUp’96 is installed. For example, if you have 
installed StepUp’96 in its default location, this macro is substituted with the following text: C:\Program
Files\Chaosoft\StepUp 

%(Windows)
Substituted with the path to the folder in which Windows is installed, usually C:\Windows. 

%(System)
Substituted with the path to the folder containing Windows system files, usually C:\Windows\System. 

%(Desktop)
Substituted with the path to the folder used to physically store file objects on the desktop, usually C:\
Windows\Desktop. 

%(Programs)
Substituted with the path to the folder containing your program groups, usually C:\Windows\Start 
Menu\Programs. 

%(Neighborhood)
Substituted with the path to the folder containing objects that appear in the network neighborhood, 
usually C:\Windows\NetHood. 

%(Personal)
Substituted with the path to the folder that serves as a common respository for documents. 

%(Templates)
Substituted with the path to the folder that serves as a common respository for document templates. 

%(Recent)
Substituted with the path to the folder that contains the your most recently used documents, usually 
C:\Windows\Recent. 

%(Send To)
Substituted with the path to the folder that contains Send To menu items, usually C:\Windows\Send 
To. 

%(Start Menu)
Substituted with the path to the folder that contains Start menu items, usually C:\Windows\Start Menu.

%(Start Up)
Substituted with the path to the folder that corresponds to the Startup program group, usually C:\
Windows\Start Menu\Programs\StartUp . 

%%



Substituted with a single character % 

%n    (where n can be a digit from 1 through 9)
Substituted with the full DOS path (without quotes) of the n-th file object selected before choosing the 
menu command. If the number of the selected file objects is less than n, the whole combination %n is
removed from the text. If the number of the selected file objects is more than one, %1 is substituted 
with the path of the primary selected file object. For example, if you have selected 2 files, “My File.txt”
and “Another File.txt” in the folder “C:\My Folder” before choosing a StepUp Menu command from 
the context menu, and file “My File.txt” is focused, then

[%1] is replaced with [C:\My Folder\My File.txt]    
[%2] is replaced with [C:\My Folder\Another File.txt]    
[%3] through [%9] are replaced with []

%*c    (where c can be any character or omitted)
Substituted with the full DOS paths (enclosed in quotes) of all file objects selected before choosing 
the menu command. If specified, character c is used as a separator between the paths. If omitted, a 
space character is used as the separator. If no file objects have been selected, the whole combination
%*c is removed from the text. For example, if you have selected 2 files, “My File.txt” and “Another 
File.txt” in the folder “C:\My Folder” before choosing a StepUp Menu command from the context 
menu, then

[%*,] is replaced with [“C:\My Folder\My File.txt”,”C:\My Folder\Another File.txt”]

!*c    (where c can be any character or omitted)
Substituted with the names (enclosed in quotes) of all file objects selected before choosing the menu 
command. If specified, character c is used as a separator between the names. If omitted, a space 
character is used as the separator. If no file objects have been selected, the whole combination !*c is 
removed from the text. For example, if you have selected 2 files, “My File.txt” and “Another File.txt” in
the folder “C:\My Folder” before choosing a StepUp Menu command from the context menu, then

[!*,] is replaced with [“My File”,” Another File”]

!*!c    (where c can be any character or omitted)
Substituted with the names and extensions (enclosed in quotes) of all file objects selected before 
choosing the menu command. If specified, character c is used as a separator between the names. If 
omitted, a space character is used as the separator. If no file objects have been selected, the whole 
combination !*!c is removed from the text. For example, if you have selected 2 files, “My File.txt” and 
“Another File.txt” in the folder “C:\My Folder” before choosing a StepUp Menu command from the 
context menu, then

[!*!,] is replaced with [“My File.txt”,” Another File.txt”]

!:
Substituted with the drive letter followed by a semicolon of the drive the primary selected file object is
located on. If there is no primary selected file object, the whole combination !: is removed from the 
text. For example, if you have set focus to the file “My File.txt” located in folder “D:\My Folder” before
choosing a StepUp Menu command from the context menu, then

[!:] is replaced with [D:]

!\
Substituted with the full directory name (including leading and trailing backslashes)    the primary 
selected file object is located in. If there is no primary selected file object, the whole combination !\ is 
removed from the text. The root directory is represented by a single backslash. For example, if you 
have set focus to the file “My File.txt” located in folder “D:\My Folder\My Subfolder” before choosing 



a StepUp Menu command from the context menu, then

[!\] is replaced with [\My Folder\My Subfolder\]

!/
Substituted with the full path of the folder (without trailing backslash) the primary selected file object 
is located in. If there is no primary selected file object, the whole combination !/ is removed from the 
text. For example, if you have set focus to the file “My File.txt” located in folder “D:\My Folder\My 
Subfolder” before choosing a StepUp Menu command from the context menu, then

[!/] is replaced with [D:\My Folder\My Subfolder]

!!
Substituted with a single character ! 

If none of the listed above file macros are recognized by StepUp Menu Handler in the text, an attempt to 
recognize and substitute the following combinations is made: 

.!
Substituted with the extension (including the leading dot) of the primary selected file object. If there is
no primary selected file object, or if the primary selected file object has no extension, the whole 
combination .! is removed from the text. For example, if you have set focus to the file “My File.txt” 
located in folder “D:\My Folder\My Subfolder” before choosing a StepUp Menu command from the 
context menu, then

[.!] is replaced with [.txt]

,!
Substituted with the extension (without the leading dot) of the primary selected file object is located 
on. If there is no primary selected file object, or if the primary selected file object has no extension, 
the whole combination .! is removed from the text. For example, if you have set focus to the file “My 
File.txt” located in folder “D:\My Folder\My Subfolder” before choosing a StepUp Menu command 
from the context menu, then

[,!] is replaced with [txt]

Finally, if none of the listed above file macros are recognized by StepUp Menu Handler in the text, an 
attempt to recognize and substitute the following combinations is made: 

!
Substituted with the name (without extension) of the primary selected file object is located on. If there 
is no primary selected file object, the character ! is removed from the text. For example, if you have 
set focus to the file “My File.txt” located in folder “D:\My Folder\My Subfolder” before choosing a 
StepUp Menu command from the context menu, then

[!] is replaced with [My File]

Note File macros can be combined to produce desired results. For example, to specify the full DOS 
path of the focused file object, you can use any of the following combinations: %1 or !/!.! or !:!\!.!

Note When using file macros take into account their relative priority. For example, the character 
combination [.!:] is parsed as [.(!:)] and replaced with [.C:] (assuming C is the name of the disk 
the focused file object is located on), whereas the combination [.!-] is parsed as [(.!)-] (since !- is 
not a file macro) and replaced with [.ext-] , where ext is the extension of the focused file.

Note When using a file macro to specify the complete path of a file object in the fields File and Start In 



of the Menu Item Properties Dialog Box, do not enclose it in quotation marks. Using macros in 
the Parameters field, however, almost always requires enclosing them in quotation marks (to 
account for long file names containing spaces). For example, to specify the full path of the 
primary selected file object enclosed in quotes, use the following combination: “!:!\!.!” (including 
quotes).




